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What’s new with version 3.2.1.242 
This interim maintenance release is designed to improve the underlying MySQL DB access speed and 
addresses some bugs where Computers Page may not load correctly.  For a summary of features and 
enhancements see list below.   

Enhancements 

➢ Computers page: Change related SQL view to work more efficiently with MySQL 5.7 

➢ Computer plugin tile: Change so the Automate Computer management screen loads quicker 

Bug fixes 

➢ Computers page: Not displaying any computers data in the grid  

➢ When the data reconciliation is happening, it is causing SQL Deadlock errors  

 

What’s new with previous version 3.2.0.236 
This important feature release allows our largest customers to use the plugin in a much more efficient manner 
and adds other important security and usability enhancements.  For a summary of features and enhancements 
see list below.  For more details, see SECTION 3 - Plugin Reference & Walkthrough. 

New Features 

➢ Global Client filter to enable vastly faster access to plugin pages by larger customers  

➢ Added Location as a new column within the Computers page to help usability  

➢ Added Active Threats value to Computers page  

➢ Added the ability to turn on ARPNOREMOVE via plugin global settings for additional security 

Enhancements 

➢ Removed Client & Location tabs and -Clone Unique Identifier option to reduce legacy technical debt 

➢ Fixed SQL injection vulnerability as well small bugs 

➢ Changed the API endpoints used with the computer data synch process to be more efficient 

➢ Restricted Threat History to 3 months to reduce strain on DBs with large numbers of detections 

How to use this manual 
This manual is in three main sections.   

Section 1 - New Webroot users start here. If you are new to Webroot or have not used a Webroot plugin 
before please follow the step by step Installation instructions for new Webroot users below.  This manual 
assumes you have already purchased Webroot and have signed into the Webroot console.  If you have not 
purchased Webroot, please contact your ConnectWise representative.   

Section 2 - users upgrading from legacy Webroot plugins, prior to version 3.x start here.  Please allow 
yourself enough time for the upgrade and actions afterwards.  Read and follow the step by step Upgrade 
instructions before commencing.  If you are upgrading from Version 3.x go to Section 3. 

Section 3 - Plugin Reference & Walkthrough.  We recommend you start in the most appropriate section first 
and then read through Section 3 – Plugin Reference & Walkthrough 

  



Integration for ConnectWise Automate User Guide 
____________________________________________________________________________________________________ 

 

 

Page 5   |  © 2020 Webroot Inc. All rights reserved. |  Proprietary and Confidential Information                                         September 16, 2020 

 

Help & ?  
Please make use of the Help tab located on the bottom left of the plugin and the video tutorials  found within 
the Client, Computers and Locations tabs throughout the plugin.   
 

 
 

  



Integration for ConnectWise Automate User Guide 
____________________________________________________________________________________________________ 

 

 

Page 6   |  © 2020 Webroot Inc. All rights reserved. |  Proprietary and Confidential Information                                         September 16, 2020 

 

SECTION 1 - Installation instructions for new users 

Step 1 – Obtaining the plugin 

If you are new to Webroot the latest Webroot plugin can be installed from CW Solution Center.  Please select 
Security and Webroot and follow the standard Solution Center installation instructions.  

 

 
Note: Please navigate to the Plugin Manager within the Control Center and Enable “Webroot SecureAnywhere 
with Unity” and “Webroot SecureAnywhere with Unity RA” and restart your Control Center, before proceeding to 
next step. 
 

  
 
Best Practice: After installation, we recommend re-loading the Reload DBAgent Plugins, Update Remote 
Agent Plugins & Reload Control Center Plugins in the order shown below. 
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Step 2 – Plugin settings 

After you have restarted the Automate Control Center, click on Webroot SecureAnywhere with Unity to open 
the plugin dashboard and select Settings. 
 

ConnectWise Automate V11.x  

 
 
ConnectWise Automate V12.x  
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Click on GSM Portal to access the Webroot Console and enter your authentication information to access the 
GSM.  

    

 

BEST PRACTICE: We strongly recommend you create a NEW USER with ADMIN rights across ALL existing 
Webroot Sites in the GSM and use the NEW USER Account for Webroot Unity Access for CW Automate.  This 
will then avoid data discrepancies if Unity users do not have Admin rights across some Webroot Sites.  Once 
complete follow instructions below.  
 

Navigate to Settings > Account Information in the GSM and copy and paste the Parent Keycode from the 
GSM to the Parent Keycode in the plugin.  Please ensure no spaces are entered at the end.  
 

   

 
 
 
 
Use the New Plugin Specific User Credentials (see Best Practice above).  Enter Console Username and 
Password in the Authentication Settings for the ConnectWise Automate Plugin. 
 

  

 

  



Integration for ConnectWise Automate User Guide 
____________________________________________________________________________________________________ 

 

 

Page 9   |  © 2020 Webroot Inc. All rights reserved. |  Proprietary and Confidential Information                                         September 16, 2020 

 

Navigate to Settings > API Access Tab and click New to create new API credentials.   

 

 

Enter a Unique Name and Description and Click Create 

 

 

Copy and paste Client Id and Client Secret to the CW Automate Plugin 
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Once all credentials are entered, click on Authenticate. 

   

 

When the credentials are successfully authenticated, Good Connection and authenticated username will be 
displayed. 

 

 

If required, please set the desired settings and click Save.  We recommend these settings are left at their default 
values at this stage.  When you are more familiar with the plugin and have had a chance to go through the 
Plugin Walkthrough, you can set these at any time.  
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Step 3 – Assigning Clients to existing Webroot Sites 

If you have already created Sites in the Webroot Global Site Manager that match your Clients and there is a 1 to 
1 relationship between CW Automate Clients & Webroot Sites, you must Assign Webroot Sites to Clients 
within the plugin.  This will establish an API connection into the GSM for each Site, pulling in correct data and 
enabling advanced functionality.  Please take your time when assigning Clients to Sites, ensure the correct 
Clients are assigned to correct Sites.   
 
If you have not yet created Webroot Sites, please go to the next step. 
 
Click on Clients tab 
Click on Select a Client  
Either select All Clients (recommended for up to 60 Clients) or select individual Clients  
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Right click on a specific Client  
Select Webroot site 
Select Assign Webroot site  
Use the drop-down menu to assign the correct site (assuming you have already created matching sites) 
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Step 4 – Creating new Webroot sites 

If you are a new Webroot user and have not created any matching Sites for your Clients, then you should create 
New Webroot Sites either directly within the plugin or within the Global Site Manager (GSM).   
 
If you do NOT have a Global Site Manager but only have a Webroot Business Console, please contact your 
Webroot representative or Webroot support. 
  
To create Sites directly within the plugin for each of your Clients, follow the instructions below: 
 
Click on Clients tab 
Right click on a specific Client  
Select Webroot site 
Select Assign Webroot site  
Select New 
Fill in the required fields and click Create 
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Step 5 – Activating Auto Deploy 

To allow the plugin to install Webroot agents, Auto Deploy setting must be enabled at the CW Automate 
Location level.  The default auto deploy setting at Location level is Auto Deploy = Disabled.  When set to 
Enabled webroot agents will start to deploy to all Computers under that Location, unless specific Computers 
have their Auto Deploy setting set to Disabled.  

To enable Auto Deploy at Location Level, click on Locations 
Right click on the relevant Location OR select multiple locations and use the Configure drop down menu 
 
Select Auto Deploy 
Select Enable to Auto Deploy  
 

  
 
Note: By default, auto deploy is set to: 

• Enabled at Client/Site level 

• Disabled at Location level  

• Enabled at Computer level 

 

Step 6 – Plugin reference & walkthrough 

Walk through the rest of the manual and enjoy the powerful new features available in the version 3.x plugin.  
Jump to the Plugin Reference & Walkthrough section and go through the rest of the manual.  
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SECTION 2 - Upgrade instructions from legacy plugins 

Step 1 – Upgrading from plugin version 2.5 or older 

Important:  When upgrading from any previous version of the Webroot plugin to Version 3.x you MUST first 
upgrade your existing plugin to version 2.5.13 before attempting to upgrade to Version 3.x.  Version 2.5.13 can 
be downloaded from the link below: 

Version 2.5.x http://download.webroot.com/RMM/LabTech/Webroot-Deploy-Solution_v2-5.zip 

 

Step 2 – Obtaining the plugin 

If you are upgrading from a previous version the latest of the Webroot plugin can be installed from CW Solution 
Center.  Please select Security and Webroot and follow the standard Solution Center installation instructions.  

 

 

IMPORTANT NOTE: After an Upgrade Webroot SecureAnywhere with Unity RA WebrootRA.dll is added to the 
CW Automate plugin manager.  Please navigate to Help > Plugin Manager within the Control Center and 
Enable “Webroot SecureAnywhere with Unity RA” and restart your Control Center, before proceeding to next 
step. 
 

 
 
 

Best Practice: After the upgrade process above, we recommend re-loading the Reload DBAgent Plugins, 
Update Remote Agent Plugins & Reload Control Center Plugins in the order shown below. 
 

   

http://download.webroot.com/RMM/LabTech/Webroot-Deploy-Solution_v2-5.zip
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Step 3 – What happens after an upgrade from plugin version 2.5 

After an upgrade from plugin version 2.5.13 of the Webroot ConnectWise Automate (CWA) plugin you should 
expect the following: 

1- Settings below are automatically transferred across 

a. The Unique Identifier Setting is set to off  

b. Alerts and pop-up settings  

c. Auto-deploy and exceptions settings  

d. Site keycodes without assignment  

Note: Automate Clients will require to be assigned to Webroot Sites for full Unity API functionality 

 

2- The plugin core functionality such as auto-deployment of Webroot agents will operate but some portions will 
not show data and will be replaced by N/A and non-GSM until Automate Clients are assigned to Webroot 
Sites  
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Step 4 – Plugin settings 

After you have restarted the Automate Control Center, click on Webroot SecureAnywhere with Unity to open 
the plugin dashboard and select Settings. 
 

ConnectWise Automate V11.x  

 
 
ConnectWise Automate V12.x  
 

 
 

 
 

Click on GSM Portal to access the Webroot Console and enter your authentication information to access the 
GSM.  
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BEST PRACTICE: We strongly recommend you create a NEW USER with ADMIN rights across ALL existing 
Webroot Sites in the GSM and use the NEW USER Account for Webroot Unity Access for CW Automate.  This 
will then avoid data discrepancies if Unity users do not have Admin rights across some Webroot Sites.  Once 
complete follow instructions below.  
Navigate to Settings > Account Information and copy and paste the Parent Keycode from the GSM to the 
Parent Keycode in the plugin.  Please ensure no spaces are entered at the end.  

 

   

 
 
 
 
Use the New Plugin Specific User Credentials (see Best Practice above).  Enter Console Username and 
Password in the Authentication Settings for the ConnectWise Automate Plugin. 
 

  

 

 

 
 

Navigate to Settings > API Access Tab and click New to create new API credentials.   
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Enter a Unique Name and Description and Click Create 

 
 

 

Copy and paste Client Id and Client Secret to the CW Automate Plugin 
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Once all credentials are entered, click on Authenticate. 

 

 

When the credentials are successfully authenticated, Good Connection and authenticated username will be 
displayed. 

 

 

If required, please set the desired settings and click Save.  
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Step 5 – Assigning Clients to existing Webroot Sites 

If you have already created Sites in the Webroot Global Site Manager that match your Clients and there is a 1 to 
1 relationship between CW Automate Clients & Webroot Sites, you must Assign Webroot Sites to Clients 
within the plugin.  This will establish an API connection into GSM for each Site, pulling in correct data and 
enabling advanced functionality.  Please take your time when assigning Clients to Sites, ensure the correct 
Clients are assigned to correct Sites.   
 
Click on Clients tab 
Right click on a specific Client  
Select Webroot site 
Select Assign Webroot site  
Use the drop down menu to assign the correct site (ensure keycode matches the imported key from previous 
version) 
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Step 6 – Creating new Webroot sites  

If you are currently mapping Webroot Groups to Automate Clients then you must create New Webroot Sites 
either directly within the plugin or within the Global Site Manager (GSM) and move the endpoints to the new 
Webroot Sites via Change Keycode command in the Webroot console.   
 
If you do NOT have a Global Site Manager but only have a Webroot Business Console, please contact your 
Webroot representative or support. 
  
To create Sites directly within the plugin, follow the instructions below: 
 
Click on Clients tab 
Right click on a specific Client  
Select Webroot site 
Select Assign Webroot site  
Select New 
Fill in required fields and click Create 
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Step 7 – Activating auto deploy 

To allow the plugin to install Webroot agents, Auto Deploy setting must be enabled at the CW Automate 
Location level.  The default auto deploy setting at Location level is Auto Deploy = Disabled.  When set to 
Enabled webroot agents will start to deploy to all Computers under that Location, unless specific Computers 
have their Auto Deploy setting set to Disabled.  

To enable Auto Deploy at Location Level, click on Locations tab 
Right click on the relevant Location OR select multiple locations and use the Configure drop down menu 
Select Auto Deploy 
Select Enable to Auto Deploy  
 

 
 
Note: By default, auto deploy is set to: 

• Enabled at Client/Site level 

• Disabled at Location level  

• Enabled at Computer level 
 

Step 8 – Plugin walkthrough 

Walk through the rest of the manual and enjoy the powerful new features available in the version 3.x plugin.  
Jump to the Plugin Reference & Walkthrough section and go through the rest of the manual.  
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SECTION 3 - Plugin Reference & Walkthrough 
Webroot plugin version 3.x is our most advanced plugin to date and makes use of the Webroot Unity API, 
unleashing more features then previously possible.  These include Policy Assignment, Site Creation, 
Workstation & Server Group policy assignment and many more.  The plugin walkthrough will take you through 
the features available. 

Note: This plugin is compatible with CW Automate v10.5 and above.   

Note: This plugin includes a separate Remote Agent plugin dll and should be noted when adding the plugin via 
the Plugin Manager.  

Dashboard 
The dashboard contains everything needed to configure and use the plugin including all options for clients, 
computers, locations, plugin settings and help links. The client, computer and location pages all contain right 
click options which are also available in the upper right as Configure and Action options. There are also various 
filters in the upper right-hand corner to help quickly view only the data desired. 

Overview tab 

The Overview tab displays a summary of the overall installation.  The user, for example can easily identify if a 
Client is without Webroot protection and can navigate to the necessary tab for quick configuration, with just a 
single click.  If certain infections have been active for longer than 24 hours, the user is alerted visually with the 
Attention Required indicator; a single click will navigate the user to the infected computer for further action.  
Quick navigation is possible from any of the numbers displayed within the “Clients” and “Computers in Webroot 
Clients” tiles. 

 

Select “None”, “All Clients” (recommended for MSPs with up to 60 Clients) or one Client at a time, recommended 
for larger MSPs for more efficient working.  The selection is persistent if plugin is Closed and re-opened.     
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Clients 

• Infected – This displays the count of clients that contain a computer in the "Infected" state.  When the 
Webroot agent detects a threat, it will block the threat.  Most threats, such as real-time or inactive threats are 
removed in under 1 minute.  Some threats require a clean scan before the endpoint is declared malware 
free.  Sometimes, threats are too deeply embedded in the system to be removed immediately without 
causing system instability and Webroot agent may require a reboot to fully remove the infection.  After the 
usual daily scan and reboot, most infections are automatically and safely removed without any intervention.   

• Attention Required – Displays the count of clients that contain a computer in the "Attention Required" state.  
To keep the malware reporting noise down to a minimum, we have created a new “Attention Required” flag 
specifically designed for MSP environments.  This flag is raised if an endpoint remains infected after 2 
contiguous 12-hour checks.  If the endpoint is rebooted or performs a scan at the point during any of the 
checks, the counter will be reset for another 12 hours.  In practice, the “Attention Required” flag will be 
true (1) if the endpoint remains infected after about 36 hours (without being rebooted or shut down).  
This ensures the endpoint has gone through at least 1 reboot/scan cycle before raising the “Attention 
Required” flag.  You can choose to take either manual or automatic action if you wish, such as initiating 
another scan or to inform the end user to reboot.  Some actions such as running a reboot request for the 
user may be automated.  See Settings Section.  

Important Note:  The “Attention Required” flag is distinctly different than the “Needs Attention” state in the 
Webroot Console, which is set as soon as an infection is detected.  Each indicator works independently. 

• Webroot – This displays the count of clients that are assigned to a Webroot site (has a Webroot site key). 

• Total – This displays the total count of Automate clients. 

Computers in Webroot Clients 

• Attention Required – This displays the count of computers in the "Attention Required" state.  See “Attention 
Required” in Clients above for full explanation.  

• Infected – This displays the count of computers in the "Infected" state.  See “Infected” in Clients above for 
full explanation.  

• Webroot – This displays the count of computers with Webroot installed that are contained in a CWA client 
assigned to a Webroot site.   

• Total – This displays the total count of computers that are contained in a CWA client assigned to a Webroot 
site.   

Note: Only computers that have a Webroot Site key assigned via the Clients tab will be added to the total.  

Threats Detected (last 7 days) 

This will display a bar chart with a count of threats detected over the last seven days. 

Webroot Agent Distribution 

This will display a pie chart with different Webroot software version being identified. 
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Clients tab 

The Clients tab lists all clients available in ConnectWise Automate and allows easy configuration of Webroot 
sites.  The following options are available within the Clients tab: 

• Assigning/Removing a Webroot site 

o Assigning an Existing site to a Client 

o Creating a new site and assigning to a Client 

o Using a non-GSM manually entered site key (for temporary use only)  

o Removing a site 

• Auto-Installation of new endpoints to 

o Workstation Group 

o Server Group  

• Auto-Deploy Enable/Disable at Client Level 

• ConnectWise Automate initiated Scans Enable/Disable 

 

Webroot Site 
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Webroot site > Assign an Existing Webroot Site to a Client  

If you have already created Sites in the Webroot Global Site Manager (GSM) that match your Automate 
Clients and there is a 1 to 1 relationship between CW Automate Clients & Webroot Sites, you can Assign 
Webroot Sites to Clients within the plugin.  This process is deliberately manual to ensure absolute accuracy.  
When all Clients are Assigned to Sites, an API connection to the GSM will be established, pulling in correct 
data and enabling advanced functionality.  Please take your time when assigning Clients to Sites, ensure the 
correct Clients are assigned to correct Sites.   

Click on Clients tab 
Right click on a specific Client  
Select Webroot site 
Select Assign Webroot site  
Use the drop down menu to assign the correct site (ensure keycode matches the imported key from previous 
version) 
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Webroot Site > Creating a New Webroot Site and assigning it to a Client  

To create Sites directly within the plugin: 

Click on Clients tab 
Right click on a specific Client  
Select Webroot site 
Select Assign Webroot site  
Select New 
Fill in required fields and click Create 

This process ensures the correct Clint name is pulled in automatically from CW Automate reducing errors  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: When a new site is created via the plugin, it may not show up in the site dropdown list immediately.  
The refresh button may need to be clicked a couple times to reload the updated site list.   
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Webroot Site > Use a non-GSM manually entered site key 

The plugin allows users to enter a manual keycode for temporary use under exceptional circumstances, 
such as when a Site is not part of the same Webroot GSM Console as the Unity API or during an upgrade 
from an older version of the plugin.  Users can then deploy endpoints to these sites via the plugin, 
maintaining backward compatibility with older versions of the plugin. 
 
NOTE: Manually entered keys cannot be tied to a GSM Unity API is tied to, advanced functionality using the 
Unity API will not be possible with manually entered keys weather they are part of a GSM or not and all 
manually entered keys will be shown as non-GSM within the computers tab. 

 
To use a manually entered site key 

Click on Clients tab 
Right click on a specific Client  
Select Webroot site 
Select Assign Webroot site  
Click within Manual Site Keycode and enter Manual Keycode  
Click Save 
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Once a manual key is assigned, the Webroot Site will show as Site Overridden.   
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Webroot Site > Remove Webroot Site  

 
To disassociate a Client from the Webroot Site, follow the process below. 

Click on Clients tab 
Right click on a specific Client  
Select Webroot site 
Select Remove  
Site will be removed immediately from the plugin 

 
 
NOTE: The Site Removal action does NOT deactivate the site in the GSM and if needed the same site or 
another site can be associated to a Client again.   
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Webroot group – Auto Deploy to Group Policy 

To assign different Webroot policies to Servers and/or Workstations in addition to the Default Webroot Site 
Policy, specific Webroot Groups can be created in the Webroot Console on a per site basis and those groups 
can be assigned within the plugin.  
 
Follow the following process to automatically assign Server and Workstation policies when new computers are 
added via the ConnectWise Automate plugin.  Note: Existing computers that have registered with the Webroot 
Console will NOT pick up the group policy, and they will need to have their policy manually changed either in the 
plugin or in the Webroot Console. 
 
Step 1 - Create either a new Global Server Policy in the GSM or use the existing Default Server Policy.  In the 
example below, we have created a new Global Server Policy called CWA Server Policy within the GSM. 
 

 
 
Step 2 - Create a Server Group in the Site Console and assign a server policy to it, e.g. CWA Server Policy 
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Step 3 – Assign the new Server Group created in the Webroot Console to the Plugin Server Group. 
 

Click on Clients tab 
Right click on a specific Client  
Select Webroot Group 
Select Assign  

 

 
 
Click on Server Group drop down menu 
Select the newly created group (e.g. Servers) 
 

 
 
Any new Servers will now pick up the CWA Server Policy automatically when Webroot Clients are deployed 
automatically. 
 
Workstation policies can be assigned in a similar manner or the Workstation policy can be assigned to the 
Default Site Policy. 
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Auto Deploy 

The Webroot Automate plugin is designed to automatically install Webroot endpoint security software on 
endpoints that have the Automate agent software installed.  Auto deploy is Disabled by default at the 
Location level.  Enabling Auto deploy at Location level will turn on auto deploy for ALL endpoint in that 
Location.  If you wish to restrict the deployment of Webroot security software the specific endpoints, then this 
must be done at the Computer level by Disabling auto deploy to specific endpoints such as Servers, BEFORE 
enabling Auto deploy at the Location level.  
 
Auto deploy can be enabled or disabled at three different levels: 
 
Client – Enabled by default 
Location – Disabled by default  
Computer – Enabled by default 
 
The above arrangement provides complete flexibility in Enabling/Disabling Auto Deploy at any level depending 
on specific requirements.  For example, if you want to accidentally avoid Webroot deployment to a Client, then 
Disable at Client level as illustrated below. 
 
NOTE: Auto deploy will ONLY work if ALL levels are set to Enable.   
 
To Enable or Disable Auto Deploy follow the steps below: 
 
Click on Clients tab 
Right click on a specific Client or highlight a number of Clients as illustrated below 
Select Auto Deploy 
Select Enable or Disable 
 

 
 
With the above example we have selected 3 Clients and Auto Deploy has been Enabled.    
 
Note: If Auto Deploy is disabled at Location or at Computer level, Auto Deploy will not work by just 
Enabling at Client level.    
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Automate scans 

You can run Webroot security scans directly within the plugin.  If you want the ability to scan any Webroot 
endpoint from the plugin, then Automate scans must be Enabled.   
 
Note: Automate scans are totally independent from Webroot Policy or Webroot Console initiated scans.  
 
Automate scans can be Enabled or Disabled at two different levels: 
 
Client – Enabled by default 
Computer – Enabled by default 
 
To Enable or Disable ConnectWise Automate plugin initiated scans follow the steps below: 
 
Click on Clients tab 
Right click on a specific Client or highlight a number of Clients 
Select Automate Scans 
Select Enable or Disable 

 

• Enable – This will Enable scans from any of the trigger scan ConnectWise Automate scripts or plugin based 
Webroot agent commands. 

• Disable – This will Disable scans from any of the trigger scan ConnectWise Automate scripts or plugin 
based Webroot agent commands. 

 

Note: If scans are Disabled on Computer level, it will override the Client level being Enabled or vice versa. 
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Computers tab 

The computers tab displays all selected computers that have a ConnectWise Automate Client installed and 
allows you to see a range of Webroot status information.  Additionally, it allows the user to initiate a range of 
actions and configurations, as seen below: 

• Webroot agent commands 

• Webroot agent policy setting 

• Auto deploy  

• Automate scans 

• Open computer 

Send Agent Command 

To send an agent command  
 
Click on Computer tab 
Right click on a specific Computer or highlight a number of Computers 
Select Send Agent Command 
Select one of four commands e.g. Poll Management Console 
 

 
 

• Poll Management Console – This will send a direct Automate command to set the registry key 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\WRData\Actions:UpdateNow value to 1. 

• Run Deep Scan – This queues the Webroot 3.x - Trigger Deep Scan script to run immediately.   

Note: Automate scans must be Enabled at both Client and Computer level for this action to work. 

Run Scan with Cleanup – This queues the Webroot 3.x - Trigger Scan with Cleanup script to run 
immediately. 

Note: Automate scans must be Enabled at both Client and Computer level for this action to work. 

• Run Customer Support Diagnostics – This will prompt for an e-mail address, auto filling with the logged in 
user's saved e-mail address, then queue the Webroot 3.x - Customer Support Diagnostics script to run 
immediately. 
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Webroot Policy 

You can set or change a Webroot policy permanently or temporarily from the ConnectWise Automate plugin, on 
one or more endpoints at the same time.  The policy will be applied to the computer almost immediately. 

To set a new policy 

Click on Computer tab 
Right click on a specific Computer or highlight a number of Computers 
Select Webroot Policy 
Select Assign Policy 
Select the policy Poll Management Console 
 

 

 
Click the drop down menu 
Click on the policy to be assigned e.g. No remediation policy 
 

 

NOTE: There are different policy types such as Local, Default & Global.  If multiple Computers are selected, only 
the policies that are common across ALL computers will be shown. 

 

If you wish to set a policy temporarily, then 
Check the box Make this policy assignment temporary 
 

 

The policy assignment will go back to the original setting indicated in red within 4 hours.   
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Auto Deploy 

The Automate plugin is designed to automatically install Webroot endpoint security software whenever an 
Automate client is installed.  Auto deploy is Enabled by default at the Computer level.  Enabling Auto deploy at 
Location level will turn on auto deploy for ALL endpoints at that Location.  If you wish to restrict the deployment 
of Webroot security software on specific endpoints, then this must be done at the Computer level by Disabling 
auto deploy to specific endpoints such as Servers, BEFORE enabling Auto deploy at the Location level.  
 
Auto deploy can be enabled or disabled at three different levels: 
 
Client – Enabled by default 
Location – Disabled by default  
Computer – Enabled by default 
 
The above arrangement provides complete flexibility in Enabling/Disabling Auto Deploy at any level depending 
on specific requirements.   
 
NOTE: Auto deploy will ONLY work if ALL levels are set to Enable.   
 
To Enable or Disable Auto Deploy follow the steps below: 
 
Click on Computers tab 
Right click on a specific Computer or highlight a number of Computers 
Select Auto Deploy 
Select Enable or Disable 
 

 

• Disable – This will exclude the selected computer/s from automatic installation of the Webroot software. 

• Enable – This will enable automatic installation of the Webroot software on the selected computer/s. 

  



Integration for ConnectWise Automate User Guide 
____________________________________________________________________________________________________ 

 

 

Page 39   |  © 2020 Webroot Inc. All rights reserved. |  Proprietary and Confidential Information                                         September 16, 
2020 

 

Automate scans 

You can run Webroot security scans directly within the plugin.  If you want the ability to scan any Webroot 
endpoint from the plugin, then Automate scans must be Enabled.   
 
Note: Automate scans are totally independent from Webroot Policy or Webroot Console initiated scans.  
 
Automate scans can be Enabled or Disabled at two different levels: 
 
Client – Enabled by default 
Computer – Enabled by default 
 
To Enable or Disable ConnectWise Automate plugin initiated scans follow the steps below: 
 
Click on Computer tab 
Right click on a specific Computer or highlight a number of Computers 
Select Automate Scans 
Select Enable or Disable 
 

 
 

• Enable – This will Enable scans from any of the trigger scan ConnectWise Automate scripts or plugin based 
Webroot agent commands. 

• Disable – This will Disable scans from any of the trigger scan ConnectWise Automate scripts or plugin 
based Webroot agent commands. 

 
Note: If scans are Disabled on Computer level, it will override the Client level being Enabled or vice versa. 
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Locations 

The locations dashboard allows you to set Auto Deployment options, as well as directly open the location from 
the dashboard. 

Auto Deploy 

The Automate plugin is designed to automatically install Webroot endpoint security software whenever an 
Automate client is installed.  Auto deploy is Enabled by default at Computer level.  Enabling Auto deploy at 
Location level will turn on auto deploy for ALL endpoints in that Location.  If you wish to restrict the deployment 
of Webroot security software the specific endpoints, then this must be done at the Computer level by Disabling 
auto deploy to specific endpoints such as Servers, BEFORE enabling Auto deploy at the Location level.  
 
Auto deploy can be enabled or disabled at three different levels: 
 
Client – Enabled by default 
Location – Disabled by default  
Computer – Enabled by default 
 
The above arrangement provides complete flexibility in Enabling/Disabling Auto Deploy at any level depending 
on specific requirements.   
 
NOTE: Auto deploy will ONLY work if ALL levels are set to Enable.   
 
To Enable or Disable Auto Deploy follow the steps below: 
 
Click on Location tab 
Right click on a specific Location or highlight a number of Locations 
Select Auto Deploy 
Select Enable or Disable 
 

 
 

• Disable – This will exclude the selected Location/s from automatic installation of the Webroot software. 

• Enable – This will enable automatic installation of the Webroot software on the selected Location/s.  
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GSM Portal 

This feature launches the default system browser to the URL https://my.webrootanywhere.com/ 
to allow additional admin tasks from the GSM console. 
 

 

 

  

https://my.webrootanywhere.com/


Integration for ConnectWise Automate User Guide 
____________________________________________________________________________________________________ 

 

 

Page 42   |  © 2020 Webroot Inc. All rights reserved. |  Proprietary and Confidential Information                                         September 16, 
2020 

 

Settings 

The settings tab allows you to enter the Webroot Unity API credentials as well as set a number of additional 
alerts and actions.   

 
API Authentication 

Allows the ability to enter and save Webroot Unity API credentials.  Please click here for a video explanation.  

 

Webroot Agent 

The Disable Webroot agent Uninstall in Apps & Features setting, when checked removes the Uninstall 
feature within Windows. 

 

NOTE: This feature is OFF by default and is only applied during installation of the Webroot agent.   

 
Alerts and Pop-ups 

Alerts and Pop-ups will allow you to enable/disable alerts from monitors. 
 

 

 

• Enable additional alerts when computers are in an “Attention Required” state 

Tied to the “Webroot 3 – Attention Required” monitor that will create an actionable ticket for techs. 

To keep the malware reporting noise down to a minimum, we have created a new “Attention Required” alert 
specifically designed for MSP environments.  This alert is raised if an endpoint remains infected after 2 
contiguous 12-hour checks from the point of infection detection.  If the endpoint is switched off during one of the 
12-hour checks or in the process of performing a scan at the end of a 12 check, the counter will be reset for 
another 12 hours.  In practice, the “Attention Required” alert will be true if the endpoint remains infected after 
about 36 hours.  This ensures the endpoint has gone through at least 1 reboot/scan cycle before raising the 
Attention Required flag.   

Important Note:  The “Attention Required” flag in the plugin is distinctly different than the “Needs Attention or 
Devices Requiring Attention” state in the Webroot Console, which is set as soon as an infection is detected.  
Each indicator works independently. 

https://detail.webrootanywhere.com/p4inbound.asp?CMD=LABTECHAPICREDS
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• Enable reboot pop-ups when computers are in an “Attention Required” state 

Tied to the “Webroot 3 – Attention Required” monitor that will create an actionable ticket for techs. 

Sometimes, for the Webroot agent to fully remediate a persistent threat, or to declare an endpoint free of 
malware, one or more reboot cycles may be needed.  If users do not shutdown their PCs overnight then it could 
remain infected.  Enabling the “reboot pop-up alert” after the “Attention Required” flag is set will ensure a pop-up 
alert is sent to the end users’ device at midday, informing the user to reboot.   

 

• Enable additional alerts when computers stay infected for longer than x hours 

Tied to the “Webroot 3 – Active Infection” monitor that will create an actionable ticket for techs. 

When a Webroot agent stays infected for longer than the amount of hours defined (2, 8, 12, 24) an additional 
alert will be triggered via the “Webroot - Active Infection” Internal Monitor.  This alert is useful for customers who 
need to be informed of persistent infections as quickly as possible.    

 

• Enable alerts when endpoint is stale for longer than x days 

Tied to the “Webroot 3 – Stale Agents” monitor that will create an actionable ticket for techs. 

If a Webroot agent fails to successfully check-in to the Webroot cloud for longer than the days defined (7, 15, 30, 
60, 90) an alert will be triggered via the “Webroot - Stale Agents” Internal Monitor.   

 

• Enable expired license alerts 

Tied to the “Webroot 3 – License Expired” monitor that will create an actionable ticket for techs. 

When a Webroot agent’s license expires it will trigger an alert via the “Webroot - License Expired” Internal 
Monitor.  Under normal circumstances all licenses are tied to the GSM Parent Key and should not expire, 
however, if you notice this alert, then it could indicate an issue with the endpoint.   
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Help 

• Customer Support – The Get Customer Support button opens the systems default bowser to: 

http://www.webrootanywhere.com/howcanwehelpbusiness.asp 

• Webroot Community – The Go to Webroot Community button opens the systems default browser to: 

https://community.webroot.com/t5/Business/ct-p/ent0 

• Webroot Manual – The Go to Webroot Manual button opens the PDF manual page in the default reader: 

https://download.webroot.com/RMM/Webroot_Integration_for_ConnectWise_Automate_User_Guide_v3-0.pdf  

 

 
 

  

http://www.webrootanywhere.com/howcanwehelpbusiness.asp
https://community.webroot.com/t5/Business/ct-p/ent0
https://download.webroot.com/RMM/Webroot_Integration_for_ConnectWise_Automate_User_Guide_v3-0.pdf
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Computer Plugin Page 
The computer plugin page provides additional details about the endpoint state such as shield status, scan 
statistics and agent status.  Endpoint specific settings such as auto deploy, automate scans and endpoint policy 
can also be set.   

To access the Computer plugin page, open a specific computer either within the Webroot plugin, for example, by 
double clicking on a computer and then click on the plugin icon and select Webroot SecureAnywhere with Unity      
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The computer plugin page is broken into two parts, System and Threat History. 

System 

This page contains details about the Webroot agent, gives the ability to Enable Auto Deploy and Automate 
Scans, set a permanent or temporary Webroot Policy, as well as issue all Webroot agent commands available in 
the plugin via the Action drop down menu. 
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Threat History 

This contains all threat information and details on that Webroot agent. 
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Monitors 
1. With the plugin installed, from the Main Toolbar of the Automate Control Center, click the Monitors button. 

 
 

 
 
This will display all the Automate monitors. 

2. Click the Internal Monitors tab.  

3. Filter on webroot.  

You should see six monitors: 

• Webroot 3 - Stale Agents 

• Webroot 3 - Reboot Needed 

• Webroot 3 - Not Installed 

• Webroot 3 - License Expired 

• Webroot 3 - Attention Required 

• Webroot 3 - Active Infection 
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CW Automate Group 
The ConnectWise Automate group created is Webroot SecureAnywhere and will contain all computers from the 
Automate system that have Webroot installed on them. It’s a sub-group of Antivirus Management group. 

Scripts 
The CWA scripts created are:  

• Webroot 3.x - Customer Support Diagnostics  

• Webroot 3.x - Install SecureAnywhere  

• Webroot 3.x - Reboot Needed  

• Webroot 3.x - Trigger Deep Scan  

• Webroot 3.x - Trigger Full System Scan  

• Webroot 3.x - Trigger Scan With Cleanup  

• Webroot 3.x - Uninstall SecureAnywhere 
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Database Tables 
If you have direct access to your database, you can verify the needed table were created. 

The following database tables should have been created:  

• plugin_webroot3_api  

• plugin_webroot3_clients  

• plugin_webroot3_computers  

• plugin_webroot3_locations  

• plugin_webroot3_settings  

• plugin_webroot3_threathistory  

Each database table has a default settings row. All checkboxes are saved as 0 or 1 in the database (0 = 
unchecked, 1 = checked). The default settings row data should match the settings page. 
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Adding/Updating Plugin via Plugin Manager 
To add or update a plugin via the LabTech Plugin Manager follow these steps in the LabTech Control Center. 

To add or update the plugin: 

1. Log in to the LabTech Control Center. 

2. From the Help menu, select Plugin Manager.  

 
 

 
 

3. Select Advanced -> Manage Plugins -> Add Plugin or Update Plugin.  
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• When adding a new plugin — If it has Remote agent functionality, you must select the Remote Agent 
checkbox before clicking the Save and Close button.  
 

 
 

• When adding a new plugin — After the plugin is added and displays in the Plugin Manager, select the 
plugin, then click the Enable icon.  
 

 
 

• When updating a plugin, you must select the desired plugin in the table. 

4. Reload the Plugins. This will ensure the plugin has fully loaded on the server and remote systems. 
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5. Select Advanced -> Reload Plugins -> Reload DBAgent Plugins, then select Update Remote Agent 
Plugins, then select Reload Control Center Plugins.  

• The order in which the reloads happen should be as described. 

• When the Remote Agent and DBAgent are updated/reloaded it will restart the database agent, wait for 
that to finish restarting before moving on to the next update/reload.  
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Known issues 
There are no know issues with this release.   
 


